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Introduction

Colorways is a new tool for ONYX 11 and Thrive 11 Textile editions. Colorways is part of the Patterns tools in 
Job Editor.  This tool makes it easy to replace the colors in a pattern. The set of replaced colors (colorways) 
can be applied to other jobs or automated using a Quick Set.

Colorways supports specific file formats, indexed color TIFF, separation TIFF and multichannel PSD. This 
document will explain the basics of each file type and using them in Colorways.

Colorways and Digital Printing

An example of a colorway is camouflage. The pattern is identical, but the colorways differ based on the type 
of environment. 

In ONYX Colorways, a single image file is used and the print operator applies a colorway based on the 
desired output. 

Designing Files for Colorways

There are many design applications that can create files that 
are supported in Colorways. This document will use Adobe 
Photoshop to describe how to create each file type. 

Description of Indexed Color

Indexed Color is a color mode used in textile work. Indexed Color 
produces images with a limited number of colors. It was designed 
to conserve file size while preserving the visual quality of the 
original image. File size reduction is accomplished by limiting the 
number of colors and storing them in a color lookup table (CLUT). 

Indexed Color has a range from 2 to 256 colors. The number of colors will vary based on the file and the 
desired output. 

Indexed Color
       
There are several important points to consider before using the Indexed 
Color mode. When an image is in the mode, Indexed Color, designing 
options are limited. It is recommended to design the file first before 
changing the image’s mode to Indexed Color.

When the Mode is set to Indexed Color, a window opens requiring user 
input to configure how the colors are reduced. 

Figure 1: Indexed Color options in Adobe Photoshop

Figure 2: Color Lookup Table (CLUT)

Important Terms and Definitions

Colorway: An Industry term that refers to a set of colors used in a pattern. 
Lab (L*a*b*):  A device independent color space that includes all human perceivable colors. 



Open or create an image. After the design is complete, select 
the Image menu and go to Mode then click on Indexed Color. 
The image must be in RGB, Bitmap or Grayscale before Indexed 
Color can be selected.  The menu in Figure 3 shows the options to 
convert the image to Indexed Color. After choosing the desired 
settings, click OK. 

The colors in the CLUT can be 
modified by going to the Image 
menu, Mode and click on Color Table. 
Each color can be modified. 
 
When the design is complete, the 

image is saved out as a TIFF file.  

Separation TIFFs

The next Colorways supported file type is separation TIFFs. A separation TIFF 
generates multiple single channel TIFF files. This can be done using CMYK, RGB,  or 
custom made channels. Each separated TIFF file represents one channel. 

Configure the channels and define where each channel will be printed on the 
image. After the image is designed, go to the Channels tab, select the menu icon 
and click Split Channels. Photoshop will now take each channel and open each in 
its own tab. Save each TIFF into the same custom folder.

Multichannel PSDs

Just like Indexed Color, design your file first before converting to Multichannel.

Multichannel PSD files are similar to separation TIFs. They are 
dependent on the number of channels and not colors. 

The option for Multichannel is not found under the Channels tab 
because it is a Mode. Go to the Image menu, select Mode and then 
click on Multichannel. 

Unlike separation TIFFs the image is not broken up into multiple 
files. The image remains mostly unchanged. There might be some 
color shift caused by the changing the color mode.  

The output for a Multichannel PSD is a single PSD file containing 
all the defined channels.

Another Consideration When Designing

If the image opening in Photoshop is a vector file type, a prompt will appear to determine how the image 
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Figure 5: Choose Split Channels from the 
Channels menu

Figure 6: Mode selection Multichannel

Figure 3: Indexed Color menu in Adobe Photoshop

Figure 4: Color lookup table (CLUT) interface in Adobe 
Photoshop



will be handled. One of the options in this window is Antialiasing. This option attempts to smooth out angles 
by reducing the noticeable pixilation between colors. This effect is achieved by adding more colors at the 
edges between objects. The figure on the 
right shows a vector file with antialiasing 
off and on. Notice the extra colors at the 
angled lines with antialiasing on. Because 
of antialiasing there are more colors that 
must be considered when converted to 
Indexed Color mode. Antialiasing should 
not be used.

Introductions to Colorways 
Interface

Colorways is in Job Editor under the 
Patterns tab. Access Colorways by clicking Enable Colorways, and then click on Colorways Setup.

Colorways is divided into four sections: File 
and Color Settings, Layer Management, 
Image and Layer Preview, and Colorways 
Library.

File and Color Settings shows the applied 
ocw file. If no ocw file is already applied it 
defaults to unnamed. A name and file can be 
saved when the user clicks Apply to Job, or 
changes to another ocw file in the Colorways 
Library. 

Below the Colorways File Name, is ICC profile 
and Colorspace fields. An ICC is needed if 
layers are changed using spot colors or Lab. 

Layer Management lists all the indexed, 
separation, or channels as individual 
layers. The number of layers depends on 
the number of colors defined in the image file’s color lookup table, number of separations or number of 
channels.  By default Colorways shows each layer in ascending levels of grayscale. The color for each layer 
can be modified by double-clicking the layer or using the Edit button.

Above the list of layers are buttons for adding layers and 
background layers, removing layers, and editing selected layers.

At the bottom of the Colorways interface is the Image and Layer 
Preview. The image preview shows the entire image with the 
active ocw colors applied. This is updates as the colors for each 
layer change.
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Figure 9: Image and Layer Preview

FIgure 8: Colorways interface

Figure 7: Antialiasing OFF compared to Antialiasing ON



The Layer View shows what parts of the file are impacted by the actively highlighted layer. Click on a layer 
above and the Layer View shows the pieces of the image that belong to that layer.  

At the right is the Colorways Library. The Colorways Library populates a list of ocw files found in the 
directory listed at the top. This directory can be configured to any location on the computer. After it has 
been set, every time Colorways is open, the directory will be shown at the top. 

The Colorways Library makes it easy to toggle between different colorways. An image that needs different 
color schemes can be easily changed from one to another. 

If any ocw files saved in the same directory as the ONYX software, they will be deleted when the ONYX 
software is uninstalled. Create a backup copy to another location, or use an external folder as the Colorways 
Library directory. 

An ocw file does not need to be saved to apply Colorways on an image in Job Editor. Ocw files provide an 
easy method to apply the same colorway to another image. They are required to automate Colorways with a 
Quick Set.

Colorways Colorspace and ICC

In Colorways there is the ICC Profile and Colorspace listed.  The Colorspace 
determines the output values used when editing a color definition on a 
layer. 

When editing a layer the Layer Space can be changed to Spot or Lab. The 
ICC selected in ICC Profiles is used for color conversions to output. If the ICC 
Profile is set to None, and the Layer Space is set to Spot or Lab, that layer will 
be ignored. All parts of the image for that layer will not be rendered. In the 
main Colorways window the layer indicates a problem by displaying red 
text under the Type column. 

If the Layer Space is defined by anything other than Spot or Lab, the ICC Profile can be set to None.

Using Colorways

Open a file into Job Editor. Go to the Patterns tab, select Enable Colorways and then click Colorways Setup. 

Select the first layer and click Edit. Colors can be configured using Spot, Lab, and Percent. In some cases the 
device color space has additional channels beyond CMYK, like CMYKOG, or CMYKRGB. It is possible to set 
Colorways to edit the layers using the device’s color space.  In the main screen of Colorways there is a drop 
down menu that lists Reset to CMYK, Reset to RGB and Reset to Device Color. Change this option to Reset to 

Device Color. The Layer Management section updates the 
values for each layer using the device color space. Select a layer 
and click Edit. The values under Percent show the output color 
channels. 

When Colorspace is set to Reset to RGB, the options for Layer 
Space changes. The available options are Spot, Lab, Value and 
Hex.
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Figure 10: Layer Space options

Figure 11: Changing the color space to the device color space



The layers can also be edited using known spot colors 
or Lab values. In Lab values the user can enter specific 
Lab values or use a spectrophotometer and measure a 
desired color. 

After the layers have been set to the desired colors, click 
Apply to Job. A window appears asking to save the current  
Colorways settings. Settings do not need to be saved to 
apply to a job. Selecting Yes provides the ability to use 
the same colorway on another file or in a Quick Set. If the 
file is saved into the Colorways Library directory, it will 
instantly appear. 

At any time in Colorways an ocw file can be saved by selecting the File menu and choosing Save or Save As.

Opening Separated TIFFs

Unlike Indexed Color TIFFs, or Multichannel PSD 
files, separated TIFF files are opened differently. 
This is done in Job Editor. Select the File menu and 
choose the option, Open TIFF Separations. Choose 
the folder where the separated TIFF files are 
located. Job Editor will open all the separated TIFF 
files as one job combined. In the Open window 
there is an option, Use Colorways. An ocw file can 
be selected to be applied.

Colorways can be turned off by deselecting the check 
box Enable Colorways. This will work for all Colorways supported filetypes except separation TIFF. In this 
situation Colorways cannot be turned off. 

After disabling Colorways, if it is re-enabled the last colorway used is applied to the job.
 
Configure a Quick Set for Colorways

Colorways can be automated using Quick Sets. Create or edit a 
Quick Set. Click on the Advanced button in the lower left. Select 
the Colorways tab. Click on Enable Colorways and then click on 
Select. Choose the desired ocw file and click OK.

All jobs opened using the new Quick Set will have the selected 
ocw file applied.

Additional Information About Colorways

If  device color space used to create an ocw file does not match the output device’s color space, a warning 
message will appear.  This can happen if the ocw file was originally built with the CMYKO device color space 
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Figure 14: Enable Colorways in the Quick Set

Figure 13: Loading a Separation TIFF folder

Figure 12: Invalid Layer Space when ICC Profile set to None



and it is being applied to a printer that only uses CMYK. The ocw file can still be applied, but the colors will 
be different because the extra channels cannot be used. 

Another situation may come when the number of layers 
does not match the number of colors defined in an 
ocw file. If the number of layers exceeds the number of 
defined colors, the extra layers will be defined as pure 
white. If the number of layers is less, the extra colors 
defined in the ocw file will not be used. In both scenarios 
the job will still be usable. 

Conclusion

For additional documentation and videos on Colorways please visit www.onyxgfx.com.
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Figure 15: Colorspace mismatch warning message


